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Chapter 1

Introducing the Program
Welcome to the Pension Distributions Calculator
The Pension Distributions Calculator calculates the minimum distributions required after
a plan owner reaches age 70½. The program also calculates the substantially equal
periodic payments that plan owners need if they are making pre-59½ distributions. For
each calculation, data is entered separately. You can apply any minimum distribution
method, including the Hybrid method and all three pre-59½ methods. To make the
calculations more realistic, you can enter a limited number of distributions for living
expenses and a limited number of contributions to the fund. Also, you can enter the
assumed dates of death for the owner and beneficiary, and you can indicate when and if a
spousal rollover occurs.
The program projects fund balances into the future, so you can forecast future distribution
requirements. You can view a distributions report illustrating the plan balance, life
expectancies, and minimum distributions. Also, view a plan balance graph that shows the
fund balance as it changes over time or a graph that displays the annual distribution
amount.
The program makes two calculations: Minimum Distributions and Pre-59 ½
Distributions.

Installation
Getting started with the Pension Distributions Calculator is easy. Before you install the
program, be sure that you’re running a Windows 95 or later operating system. The
Pension Distributions Calculator does not run on Windows 3.1 or earlier operating
systems.
Installing the Program
Insert the disk into the disk drive.
On the Windows Taskbar, click the Start button.
On the Start menu, click Run. The Run dialog box appears. In the Open box,
A:\setup.EXE should appear. If it doesn’t, type A:\setup.EXE.
Click OK.
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The setup program begins. Follow the instructions in the setup program.
Uninstalling the Program
1. On the Windows Taskbar, click the Start button.
2. Point to Settings and click Control Panel. The Control Panel window appears.
3. Click Add/Remove Programs. The Add/Remove Program Properties dialog box
appears.
4. Use the scrollbar to find the Pension Distributions Calculator. When you find it,
click the program title. Notice that the Add/Remove button is now functional.
5. Click the Add/Remove button.
6. The uninstall program begins. Follow the instruction in the uninstall program.
What Do I See on the Screen?
When you run the program, the Pension Distributions Calculator window opens.
Following are brief descriptions of what you see.
Title Bar
The title bar appears in the top of the window. It contains the following information:
• Program Title
• Program version number
• File name (if the file has been saved)
Menu Bar
The Menu bar is below the title bar. The Menu bar contains three menus that you use to
make program commands.
Toolbar
The toolbar is below the menu bar. The toolbar contains graphics that you click to
execute frequently used program commands. You can use these graphics instead of using
the related Menu bar commands.

Open Files.
Save Files.
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Print Files.

Get Help.
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Data Entry Section
A data entry section appears in the left side of the window. Use this section to calculate
minimum distributions.
Command Buttons
Three command buttons appear below the data entry section. Use these to enter additional
distributions, contributions, and dates-of-death information.
Display Area
The right side of the window is the display area. Here, you can view graphs or reports
that display the results of the calculations.
Hint Line
The Hint Line displays short commands to help you with data entry. As you move the
pointer across buttons, input boxes, and other areas of the window, the Hint Line displays
different commands.

Shortcut Keys
Use the function keys for frequently used commands:

F1

Access the Help system.

F2

Save files.

F3

Open files.

F6

Print reports.

F7

Create a new file.
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Chapter 2

Working with Files

Frequently Used Procedures
Refer to this chapter to view instructions for procedures that you’ll frequently use when
working with files.
Create a New File
7. On the File menu, click New. The program clears all previous data entry and
resets the program’s default values.
Open an Existing File
8. 1. On the File menu click Open. Or on the toolbar, click the Open graphic. The
Open dialog box appears.
9. 2. In the File name box, enter the name of the file and the proper extension. Be
sure you have selected the proper drive and folder that contain your file.
Reopen File
10. On the File menu, click Reopen File. A list of files you’ve worked on recently
will appear. Select the name of the file you wish to reopen.
Save a File
11. 1. On the File menu, click Save. Or on the toolbar, click the Save graphic.
12. 2. If the file has not been saved previously, the Save As dialog box appears.
13. 3. In the File name box, type a name for the file. The program automatically adds
.PDC extension to the file name.
14. 4. Select the drive and folder in which to save the file.
Save an Existing File (Save As)
15. Open an existing file or create a new file.
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16. On the File menu, click Save As. Or on the toolbar, click the Save graphic. The
Save As dialog box appears.
17. In the File name box, enter a name for the new file. The program automatically
adds the proper extension to the file name.
18. Select the drive and folder in which you want to save the file.
Access the Print Report Window
•

On the File menu, click Print.

Set up a Printer
19. 1. On the File menu, click Print Setup. The Print Setup dialog box appears.
20. 2. For help with setting up a printer, click

in the Print Setup dialog box.

Exit the Program
21. 1. On the File menu, click Exit. A Warning appears.
22. 2. To save your data and create a file, click Yes. The Save As dialog box appears.
23. 3. Save the file.
24. 4. To close the program without saving your data, click No. To continue running
the program, click Cancel.

Options Menu
Click Specify Distributions to enter additional distributions.
Click Additional Contributions to add contributions.

Clicking Pre-59 ½ Distributions on the Options menu is the same as clicking the
Calculate Pre-59 ½ Distributions button.
AFR Rates: The AFR Manager stores a list of available rates starting from January 1989
through the present month. The rates are needed for a number of calculations in the
program (e.g., Charitable Remainder Annuity Trust or Grantor Retained Annuity Trust).
The Applicable Federal Mid-Term 120% Annual Rate changes monthly and is reported in
The Wall Street Journal. (See the Federal Interest Rates in the Money and Investing
section of the Journal, generally between the 18th and 23rd of the preceding month.) This
rate can often be found earlier on Brentmark’s web site at
http://www.brentmark.com/AFRs.htm.
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Note: If a §7520 Rate entry field shows 30%, the AFR table must be updated. Thirty
percent is the default value that appears when there is not a current AFR available for the
chosen Transfer Date. Download or manually update your AFR table.

Update the AFR Manager
There are two ways to update the AFR Manager: use the Download Latest AFRs button
or click the button with the world image on it.

Download Latest AFRs button
1. Click the Download Latest AFRs button. A confirmation window appears.
2. Click Yes. The rates will download into the program.
Note: If you have internet access through a commercial proprietary service (e.g.,
AOL, Compuserve, Prodigy) you must establish a connection before selecting this
option from the menu. If you are connected through a network or a cable modem,
your internet connection is already established.

World image button
1. Click the button with the world image on it. The following options are available:
• Download AFR Rate
• Go to AFR Web Page
2. If you select Download AFR Rate:
a. A confirmation window appears.
b. Click Yes. The rates will download into the program.
3. If you select Go to AFR Web Page:
a. You are automatically connected to the AFR Rates page on Brentmark’s
web site.
b. View or manually enter the rates into the AFR Manager.
Click Take Distributions at End of Year to distribute required minimum distributions at
the end of the year. By default, all fund activity takes place at the beginning of the year.
This includes required minimum distributions and any additional distributions. If you
prefer, you can have all fund distributions occur at the end of the year.
Click Report Options to format your reports.
Click 16 Color Display to view the program in 16 colors.
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Click File Location to select the folder where the data will be located. Then click the
Browse button to view your available drives and choose the default file location. Click
the title of the report or graph to view it.
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Chapter 3

Calculating Minimum Distributions
Minimum Distributions
To calculate required minimum distributions, you’ll enter data in the portion of the
program pictured here. By default, all fund activity takes place at the beginning of the
year. This includes required minimum distributions, any additional distributions, and any
contributions. To make all distributions from qualified plans occur at the end of the year,
on the Options menu, click Take Distributions at End of Year.
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Minimum Distributions Calculation: Table of Inputs
Input

Description

Type of Plan

Select the type of qualified plan. For details on the types of
plans that the program considers qualified, see Chapter 11,
Reference Material.

Expected Plan Growth

Enter the expected annual percent increase of the plan.

Is there a Designated
Beneficiary?

Select whether there is a designated beneficiary by clicking yes
or no.

Owner’s Birth Date

Enter the plan Owner’s Birth Date in month/day/year format. If
an owner’s birth date is before 1917, the program displays a
warning in the Hint Line. The minimum distributions rules for
owners with birth dates prior to 1917 are more complex and
may be different than the current rules. Therefore the program
bases its calculations on minimum distributions rules after
1917 (see Proposed Treas. Reg. Sec.1.408-8 for IRAs and
1.401(a)(9) for Qualified Plans).

Beneficiary’s Birth Date

Enter the Beneficiary’s Birth Date in month/day/year format.
The program uses the beneficiary’s birth date to determine
joint life expectancy factors as well as a single life expectancy
for the beneficiary.

Assume Death Occurs

Click Assume Death Occurs and the Benef. Info button to enter
Assumed Dates of Death and Spousal Rollover information.
Note
To include a spousal rollover, you need to click the Assume Death(s)
Occur(s) check box. Then click the Benef. Info button.
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Chapter 4

Including Dates of Death and Spousal Rollovers
Use the Beneficiary Info Used After Owner’s Death dialog box to handle the death of
either the plan owner, the beneficiary or both. Also, for cases in which the plan owner
dies, you can indicate when a spousal rollover will occur. To enter dates of death and
spousal rollovers, click Assume Death Occurs check box and the Benef. Info button in
the Main window.

Input

Description

No Death

Click to indicate that the Owner or Beneficiary does not die
during the analysis.

Calculated Year of Death

Click to have the program calculate the year of death based
upon the birth dates.

Entered Year

Click to enter a specific year of death for the Owner or
Beneficiary.

No Rollover

Click to indicate that the spouse distributes the plan upon the
owner’s death.
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Spousal Rollover Information
Input

Description

No Death

Click to indicate that the spouse does not die during the
analysis.

Calculated Year

Click to have the program calculate the year of death based on
birth dates.

Entered Year

Click to enter a specific year of death for the Owner or
Beneficiary.

Spouse’s Beneficiary’s
Birth Date

Enter the birth date for the heir.

Recalculate Spouse’s Life
Expectancy after Rollover

Click to use a recalculation method for determining the
spouse’s minimum distributions.

25.
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Calculating Pre-59½ Distributions
Pre-59½ Distributions Calculator
Use the Pre-59½ Distributions Calculator to
calculate the “substantially equal periodic
payments” that plan owners need to make in
order to avoid the 10% penalty for early
distributions. We’ve divided this process into
three steps. To access the Pre-59 ½
Distributions Calculator, click Pre-59½ on the
toolbar. The Pre-59½ distributions screen
shows only those inputs that are relevant to the
current case. If the input is irrelevant to the
case, the input field will disappear. Enter
information in order (from top to bottom).

Input

Description

Starting Date:

Enter the first year that the plan owner needs the Pre-591/2
Distribution. When the Distribution Frequency is
Semiannual, Quarterly, or Monthly, the Starting Date
determines the date of the pre-50 ½ distribution.

Distribution Year:

For most cases, this input should be the same as the year of
the Starting Date. However, if your client started taking
Pre-59½ Distributions in a previous year, you can use this
input to calculate the distributions for the current year. Set
the Starting Date to be when Distributions started, and enter
the current year as the Distribution Year.

Use Rev Rule 2002-62?

Answer yes or no. See “Revenue Rule 2002-62” in Chapter
11, Reference Materials).

Distribution Method:

There are three methods for calculating early distributions:
Minimum Distributions, Amortization, and Annuity Factor
(see the IRS Notice 89-25 in Chapter 11, Reference
Materials.)
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Calculation Method:

Pre-2002, for most cases, select IRS Notice 89-25. Private
Letter Rulings (among them 9531039, 9010075, and
9241063) illustrate an annual recalculation of distributions
for the annuity factor and amortization methods. More
specifically, in years after the first year, the distributions
are recalculated using the balance as of the beginning of
each year. If you wish to see the distributions calculated
using the methodology of the Letter Rulings, select
“Private Letter Rulings” for the choice. The program
includes disclaimer language on all reports that use the
method of the Private Letter Rulings. These Letter Rulings
deal with cases involving the start of new qualifying
distributions. They do not deal with cases involving
distributions that have already commenced.

Plan Balance:

Enter the value of all assets in the plan. The Minimum
Distributions rules require that you enter the balance of the
plan as of December 31 of the year preceding the first year
of analysis. After the first year, the Private Letter Rulings
also use the 12/31 plan balance to calculate distributions.
This input is enabled only when it is relevant to the
calculations. When Rev. Rule 2002-62 applies, the
minimum distributions method is calculated using the
balance as of the first distribution in each year.

Expected Plan Growth:

Enter the expected annual growth of the plan. This rate is
not used to calculate the distributions but is just used for
projections.

Distribution Frequency:

Select a Distribution Frequency. Plan owners can make
pre-59½ distributions Annually, Semiannual, Quarterly, or
Monthly. Depending on the Distribution Frequency, the
Plan Balance is calculated differently. For example, if the
Distribution Frequency is Annual, the growth is
compounded only once each year. If it is Semiannual,
compounding occurs twice. If it is Quarterly, compounding
occurs four times each year. If it is Monthly, then
compounding occurs every month.

Joint/Single Life Exp.:

Select whether to base the calculation of distributions on a
single or a joint life expectancy.

Birth Dates:

Enter the owner’s birth date and the beneficiary’s birth date
in month/day/year format. The beneficiary’s birth date is
used to determine joint life expectancy factors.
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“Reasonable” Interest Rate:

If the Distribution Method is Annuity Factor or
Amortization, enter a “Reasonable” Interest Rate (see
Chapter 11, Reference Material). To create a Comparison
Report, you need to enter a Reasonable Interest Rate.

Use Uniform Life Table:

If the owner is still alive, the life expectancy is taken
straight from the Uniform Lifetime Table. Simply find the
owner’s age on the table (it covers ages 70 through 115),
and use the life expectancy listed. For this situation, the
only change caused by the 2002 final regulations was to
update the numbers in the Uniform Lifetime Table.

Annuity Factor Table:

If the Distribution Method is Annuitization Factor, select
the Mortality Table (or details, see Chapter 11, Reference
Material) that the program will use to calculate annuity
factor. To create a Comparison Report, you need to choose
an Annuity Factor Table.
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Including Contributions & Additional Distributions
Contributions
Use the Enter Contributions to the Qualified Plan dialog box to enter contributions to an
analysis. For example, many employers contribute to employee retirement funds. To
enter contributions, click the Specify Contributions button in the Main window.

Enter Contributions to Qualified Plan box
Input

Description

Annual Amount

Enter the annual amount of each contribution.

Growth Rate

Enter the annual percent increase of the contribution.

First Year

Enter the first year that the contribution is needed.

Last Year

Enter the last year that the contribution is needed.

Note
These contributions are added to the fund at the beginning of each year, just after the distribution amount is
withdrawn. Generally, additional contributions cannot be made after the required beginning date.
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Distributions
Use the Enter Desired Plan Distributions dialog box to enter additional distributions to an
analysis. For example, your clients might make distributions to other assets or use
distributions for living expenses. You can model the analysis so the entire fund is
distributed in one year or over a period of years.
By default, all fund activity takes place at the beginning of the year. This includes
required minimum distributions and any additional distributions. To make all fund
distributions occur at the end of the year, on the Options menu, click Take Distributions
at End of Year.
To enter distributions, click the Specify Distributions button in the Main window.

26.
Note

The program uses these distributions whenever they are greater than the calculated minimum distribution.
The program will not allow the distributions to drop below the calculated minimum. The program always
distributes at least the required minimum distribution, so don’t worry if the distribution is too small. If you
enter a distribution that is larger than the fund balance, the program distributes the balance.

Enter Desired Plan Distributions box
Input

Description

Annual Amount

Enter the annual amount of each contribution.

Growth Rate

Enter the annual percent increase of the contribution.

First Year

Enter the first year that the distribution is needed.

Last Year

Enter the first year that the distribution is needed.
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Reports
The program displays calculation results in four reports and two graphs:
•

Distributions Report

•

Distributions Graph

•

Plan Balance Graph

•

Pre-59½ Distributions Report

•

Pre-59½ Comparison Report

Viewing Reports and Graphs
On the toolbar, click
•

View Report—to view the Distributions Report.

•

Plan Balance Fund—to view the Plan Balance Graph.

•

Distributions—to view the Distributions Graph.
Note
When viewing the graphs, the x-axis represents years, and the y-axis represents the plan balance in dollars.
If you select Use Pre-59½ Distributions, the graphs include these calculations.

Current Year Report
The Current Year Report simply prints the current year and the distribution amount. You
can only print this report.
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Distributions Report
The Distributions Report displays the following information:

Column

Description

Year

This column lists each year that the program calculates
a distribution. By default the program displays years of
death in red. You can change the color in the Report
Options window.

Age

This column lists the owner’s age in each year. Even if
the owner is dead, the owner’s age appears in this
column.

Plan Balance

This column lists the total amount of money in the
owner’s qualified plan in each year. To calculate the
Plan Balance for each year, the program uses the
following formula:
(Current Plan Balance) * (1+ Expected Plan Growth) –
(Calculated Distribution) + (Contributions)
When you use the Pre-59½ Distributions, the results of
these calculations appear in every report. However, the
report that appears in the Main window displays results
with growth that has been compounded annually.
Therefore, results that appear in the Main window and
the Pre-59½ Distributions window may have different
balances.

Life Expectancy Factor

This column lists the life expectancy factors that the
program uses to calculate the minimum distribution. To
calculate the life expectancy factors, the program uses
the ages of the Owner and/or the Beneficiary and
applies them to the minimum distribution rules.

Distribution

This column lists the distributions in each year. This
includes any distributions you enter in the Enter
Desired Plan Distributions box and the minimum
distribution in each year. To calculate the minimum
distribution amount, the program divides the Plan
Balance by the Life Expectancy factor. If you have
included Pre-59½ Distributions, the annual Pre-59½
Distribution appears in this column.
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Contribution

This column lists the total contributions in each year. If
you have not specified contributions, the column does
not appear.

Pre-59½ Distributions Report
When you use the Pre-59½ Distributions, the results of these calculations appear in every
report. However, the report that appears in the Main window displays results with growth
that has been compounded annually. Therefore, results that appear in the Main window
and the Pre-59½ Distributions window may have different balances.
Pre-59½ Distributions have to last for 5 years and must be paid until the plan owner
reaches age 59½. Usually, this results in distributions being made for a portion of the year
that the owner reaches age 59½. For example, if distributions are taken quarterly, and the
plan owner turns age 59½ in February 2010, only the first distribution has to be in 2010.
If distributions occur at the end of each quarter, no distribution would have to be made in
2010 (assuming that five years worth of distributions have already been taken).

Column

Description

Year

This column lists each year that the program calculates a
distribution.

Age

This column lists the owner’s age in each year. This
column only appears when the Distribution Frequency is
Annual.

Month

This column appears when the Distribution Frequency is
anything other than Annual. The column displays the
month in which each distribution occurs.

Plan Balance

This column lists the total amount of money in the owner’s
plan in each year. Depending on the Distribution
Frequency, the Plan Balance is calculated differently. For
example, if the Distribution Frequency is Annual, the
growth is compounded once per year. If it is Semiannual,
compounding occurs twice. If it is Quarterly, compounding
occurs four times per year. And if it is Monthly,
compounding occurs every month.

Life Expectancy Factor

If you select the Minimum Distribution method, this
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column lists the life expectancy factors that are used to
calculate the minimum distribution. To calculate the life
expectancy factors, the program uses the ages of the Owner
and/or the Beneficiary applies them to the minimum
distribution rules.
If you select the Amortization method, the column also
lists a life expectancy factor. The program amortizes the
plan balance over the life expectancy to arrive at the annual
distribution.
If you select the Annuity Factor method, this column
displays the annuity factor from the Mortality Table that
you choose.
Distribution Amount

This column lists the minimum distribution in each year.
To calculate the minimum distribution amount, the
program divides the Plan Balance by the Life Expectancy
factor.

Pre-59½ Comparison Report
The Pre-59½ Comparison report compares the dollar amount of annual distributions for
each of the three Distribution Methods. In order to create the Pre-59½ Comparison, you
need to enter a “Reasonable” Interest Rate, and you need to select a Mortality Table, no
matter which Distribution Method you use.
View the Pre-59½ Comparison Report
27. On the toolbar, click Pre-59½.
28. In the Pre-59½ Distributions Calculator window, click the Comparison tab.
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Printing Reports & Graphs

Print Report Window
Use the Print Report window to select reports and graphs for printing and to select
printing options (for more printing options, see Report Options window). Also from the
Print Report window, you can save a report as a Text or Spreadsheet file. Before printing,
be sure that your printer is set up and that you’ve formatted your printed reports in the
Report Options window.
Set up a Printer
29. On the File menu, click Print Setup. The Print Setup dialog box appears.
30. For help with setting up a printer, click

in the Print Setup dialog box.

Access the Print Report Window
There are three ways to access the Print Report dialog box.
•

On the toolbar, click the Print graphic.

•

On the File menu, click Print.

•

In the Pre 591/2 Distributions window, click the Print button.

Preview a Report
•

In the Print window, click Print Preview. In the Print Preview window, click
Zoom to magnify the view.

Print a Report
31. On the File menu click Print. Or on the toolbar, click the Print graphic. The
Print Report window opens.
32. Click the reports and graphs that you want to print.
33. Select printing options.
34. Click the Print Report button.
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35. For more printing options, click the Report Options button.
Print to File
On the File menu click Print. Or on the toolbar, click the Print graphic. The Print Report
window opens.
Click the Print to File button. The Print to File window opens.
Select from one of four file types, which you can edit or send as e-mail attachments:
Text file: saves the file with a .txt extension, which can be opened in any word processor
Spreadsheet file: saves the file with a WK1 extension, which can be opened in Excel,
Lotus, or Quattro Pro
HTML: saves the file with an .html extension, which is used most commonly on the
Internet but can be read by most word processors
DOC: if you have Microsoft Word 97 or later, saves the file with a .doc extension, which
can be opened in Word
4. Click the Create File button. The Save As window opens. Enter a file
name and specify a directory to which the file should be saved.
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Formatting Reports
Report Options Window
Use the Report Options window to format your reports and graphs for printing. The
Report Options window allows you to create headings, format text and layout, and
include other options for printing. All report options are automatically saved, so the next
time you run the program, you don’t have to reformat your reports.
Access the Report Options Window
There are two ways to access the Report Options window:
•

On the Options menu, click Report Options.

•

In the Print Report window, click the Report Options button.

Create a Heading for a Report
36. In the Report Options window, click the Heading box.
37. Type the text that you want to display at the top of your printed report.
Format Page Margin
•

Under the Page Margins heading in the Report Options window, enter the Top,
Bottom, Left, and Right page margins (in inches).

Format the Text of a Report
38. Under the Fonts heading in the Report Options window, click the text you want
to format. The Font dialog box appears.
39. Select the Font, Style, Size, and Effects to apply to the text and click OK.
40. Notice that the description of the text in the Report Options window has changed.
Print for Windows NT
•

Under the Select Printing Options heading in the Report Options window, click
NT-Style Printing.
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Print the Date and Time
There are two ways to include the date and time on printed reports:
•

In the Print Report window, click the Date and Time check boxes.

•

Under the Select Printing Options heading in the Report Options window, click
the Print Date and Print Time check boxes.

Select the Number of Copies to Print
41. Access the Print Report window.
42. In the Number of Copies box, enter the number of selected reports that you want
to print.
Print Page Numbers
There are two ways to include page numbers on printed reports:
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•

In the Print Report Window, click the Page Numbers check box.

•

Under the Select Printing Options heading in the Report Options window, click
the Print Page Numbers check box.

Chapter 10

Getting Help

If you need help, it’s easy to find. Click the question mark wherever it appears in the
program and a Help topic appears for the window in which you are working. Also, use
the Help menu, and if you still need help, Brentmark provides technical support.

Help Menu
Use the Help menu to access the Help system, learn how to use Help, or view information
about this product and other Brentmark products.

Help System
The program provides a complete Help system, so you can get help whenever you need
it. Just click the question mark that appears in the top right corner of every data entry
section. Use the Help system’s table of contents to view Help topics by category or
search the Help index for specific terms.

Technical Support
Technical Support is available by telephone, fax, e-mail, or postal mail. If you have
questions concerning program calculations, please have a list of your exact data entry
values available when contacting us.
Telephone

Assistance by telephone is available Monday through Friday between 9:00 AM and 6:00
PM Eastern Standard Time at (407) 306-6160.
Fax

For assistance by fax, send your fax to (407) 306-6107.
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E-mail

For assistance via e-mail, send your remarks to support@brentmark.com.
Postal Mail

For assistance by postal mail, write to:
Brentmark Software, Inc.
3505 Lake Lynda Drive, Suite 212
Orlando, FL 32817-8327

In your correspondence, please include the following information:
•

The name to which the program is registered.

•

A contact phone number.

•

The program name and version number.

•

Your system configuration.

•

A sample printout or description of the problem.

•

A list of any error messages that have appeared.

Brentmark on the Web

•
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On the toolbar, click the globe graphic to access Brentmark’s website.
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Reference Material
To keep procedures short and free of lengthy discussions, this manual refers to the
following material. The material is listed alphabetically.

Beneficiary
If plan owners designate a beneficiary, the minimum distribution rules allow plan owners
to withdraw retirement plan funds over the joint life expectancies of the plan owner and
the beneficiary. When you include a beneficiary in your analyses, the program uses joint
life expectancy factors based on the ages of the plan owner and beneficiary. Generally,
the term beneficiary refers to an individual. If the beneficiary is the spouse of a Roth IRA
owner, the annual election to recalculate the beneficiary’s single life expectancy after the
required beginning date is available.
For non-spousal beneficiaries, the life expectancy is calculated once, and it is reduced by
one for each year after the required beginning date. Non-spousal beneficiaries have
additional limitations placed on their calculated distributions:
•

A non-spousal beneficiary is not permitted to recalculate his or her life
expectancy in each year.

•

For minimum distributions, non-spousal distribution calculations are subject to
the MDIB requirements.

The program automatically handles both of these additional limitations for you. If there is
more than one person named as the beneficiary (for example, children of the plan owner),
the age of the beneficiary with the shortest life expectancy must be used to calculate the
joint life expectancy.
If a charity or the plan owner’s estate is named as the beneficiary, there is no “designated
beneficiary,” and funds must be withdrawn over the plan owner’s life expectancy. A trust
can also be named as the beneficiary. In such cases, the life expectancy of the trust’s
beneficiary can be used to calculate the joint life expectancy. If the trust does not meet
the following rules, then only the life expectancy of the plan owner may be used to
calculate distributions:
•

Trusts must be valid under state law (or would be valid under state law if it had a
trust corpus).

•

Trusts must be irrevocable as of the required beginning date.

•

Trusts must benefit an individual or a specified class of individuals so that the life
expectancy can be determined.
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•

Trusts must be copied, and a copy must be given to the plan administrator by the
required beginning date.

IRS Notice 89-25
Excerpts from IRS Notice 89-25, 1989-1 C.B. 662
Q-11: Does the 10-percent tax under section 72(t) apply to amounts that are included in a
plan participant’s gross income pursuant to section 72(m)(3)?
A-11: No. Section 72(m)(3) provides generally that employer contributions and trust
income that are treated under regulations as having been applied to the purchase of life
insurance protection for a plan participant must be included in the participant's gross
income. However, such an amount is not treated as a distribution for purposes of section
72(t).
Q-12: In the case of an IRA or individual account plan, what constitutes a series of
substantially equal periodic payments for purposes of section 72(t)(2)(A)(iv)?
A-12: Section 72(t)(1) imposes an additional tax of 10 percent on the portion of early
distributions from qualified retirement plans (including IRAs) includable in gross
income. However, section 72(t)(2)(A)(iv) provides that this tax shall not apply to
distributions which are part of a series of substantially equal periodic payments (not less
frequently than annually) made for the life (or life expectancy) of the employee or the
joint lives (or joint life expectancies) of the employee and beneficiary. Section 72(t)(4)
provides that, if the series of periodic payments is subsequently modified within five
years of the date of the first payment, or, if later, age 59½, the exception to the 10 percent
tax under section 72(t)(2)(A)(iv) does not apply, and the taxpayer’s tax for the year of
modification shall be increased by an amount, determined under regulations, which (but
for the 72(t)(2)(A)(iv) exception) would have been imposed, plus interest.
Payments will be considered to be substantially equal periodic payments within the
meaning of section 72(t)(2)(A)(iv) if they are made according to one of the methods set
forth below.
Payments shall be treated as satisfying section 72(t)(2)(A)(iv) if the annual payment is
determined using a method that would be acceptable for purposes of calculating the
minimum distribution required under section 401(a)(9). For this purpose, the payment
may be determined based on the life expectancy of the employee or the joint life and last
survivor expectancy of the employee and beneficiary.
Payments will also be treated as substantially equal periodic payments within the
meaning of section 72(t)(2)(A)(iv) if the amount to be distributed annually is determined
by amortizing the taxpayer's account balance over a number of years equal to the life
expectancy of the account owner or the joint life and last survivor expectancy of the
account owner and beneficiary (with life expectancies determined in accordance with
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proposed section 1.401(a)(9)-1 of the regulations) at an interest rate that does not exceed
a reasonable interest rate on the date payments commence. For example, a 50 year old
individual with a life expectancy of 33.1, having an account balance of $100,000, and
assuming an interest rate of 8 percent, could satisfy section 72(t)(2)(A)(iv) by distributing
$8,679 annually, derived by amortizing $100,000 over 33.1 years at 8 percent interest.
Finally, payments will be treated as substantially equal periodic payments if the amount
to be distributed annually is determined by dividing the taxpayer's account balance by an
annuity factor (the present value of an annuity of $1 per year beginning at the taxpayer's
age attained in the first distribution year and continuing for the life of the taxpayer) with
such annuity factor derived using a reasonable mortality table and using an interest rate
that does not exceed a reasonable interest rate on the date payments commence. If
substantially equal monthly payments are being determined the taxpayer's account
balance would be divided by an annuity factor equal to the present value of an annuity of
$1 per month beginning at the taxpayer's age attained in the first distribution year and
continuing for the life of the taxpayer. For example, if the annuity factor for a $1 per year
annuity for an individual who is 50 years old is 11.109 (assuming an interest rate of 8
percent and using the UP-1984 Mortality Table), an individual with a $100,000 account
balance would receive an annual distribution of $9,002 ($100,000/11.109 = $9,002).

Minimum Distribution Incidental Benefit (MDIB)
Non-spousal distributions will be subjected to the Minimum Distribution Incidental
Benefit (MDIB) requirement (see IRC Proposed Treas. Reg. §1.401(A)(9)-2). The MDIB
requirement states that any distribution occurring after the required beginning date must
be less than the distribution that was calculated by dividing the balance of the plan by the
MDIB Table divisor found in IRC Proposed Treas. Reg. §1.401 (a)(9)-2, Q-4. Generally,
when the non-spousal beneficiary is more than ten years younger than the plan owner, the
MDIB is triggered and results in a joint life expectancy factor, regardless of the actual
age of the non-spousal beneficiary. Thus, during the lifetime of the plan owner but after
the plan owner reaches age 70½, there is no difference in the minimum distribution
payout amount, regardless of whether the non-spousal beneficiary is 15 or 30 years
younger than the plan owner is.
The program always removes the MDIB limitation after the plan owner’s death.
Authority for Removal of MDIB after the death of the plan owner is found in IRS
Publication 590 and IRC Proposed Treas. Reg. §1.401(a)(9)-2, Q&A Q-3. If the owner
made an appropriate election before the required beginning date, a joint term certain
method will be used after the plan owner’s death (rather than just a single life term
certain for the beneficiary in cases where the owner was using a recalc method).
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Required Minimum Distributions: Calculations under the Final Regulations
After more than a decade of proposed regulations, final minimum distribution regulations
were published on April 17, 2002. These new rules are based primarily on the proposed
regulations of 2001, but they do add some new calculation wrinkles to consider.
As with the 2001 proposed regulations, the final regulations keep the basic calculation
intact. Each year, the distribution is calculated by dividing the previous year’s ending
balance by a life expectancy number. The calculation complexity lies in determining the
life expectancy number.
Here’s how the new rules work:
Situation I: Owner still alive
If the owner is still alive, the life expectancy is taken straight from the Uniform Lifetime
Table. Simply find the owner’s age on the table (it covers ages 70 through 115), and use
the life expectancy listed. For this situation, the only change caused by the 2002 final
regulations was to update the numbers in the Uniform Lifetime Table.
Prior to 2001, the Uniform Lifetime Table was known as the MDIB table, and was used
only for nonspousal beneficiaries. Now, it is used whenever the owner is alive, making
the distribution calculation very straightforward. There is only one exception to this rule:
cases involving spousal beneficiaries who are more than ten years younger than the
owner. In that case, the joint life expectancy of the owner and spouse is used. Once the
owner dies, this exception no longer applies, and Situation 4 (see below) applies.
Situation 2: Owner dies with no beneficiary
In the year of death, the minimum distribution is still calculated according to Situation 1
(above). It’s only in the years after the owner’s death that this situation applies.
If the owner dies before the required beginning date, and there is no beneficiary alive as
of the owner’s death, the five year rule applies—all the money has to be distributed
within five years of the year the owner died.
If the owner dies on or after the required beginning date, and there is no beneficiary alive
as of the date of death, distributions after the owner’s death are taken over a term based
on the owner’s life expectancy in the year of death. This calculation is easier than it
sounds. For the year after death, subtract one from the owner’s single life expectancy in
the year of death. As each year passes, reduce the life expectancy by one. For example, if
the owner died in 2003, the distribution in 2004 would be based on the owner’s 2003 life
expectancy minus one.
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The new life expectancy tables used by the 2002 final regulations add some complexity
to cases where the owner has already died. If distributions are being taken under this
scenario, the length of the term has to be recalculated using the 2002 single life
expectancy table. For example, if a plan owner died in 1995, the 2003 distribution would
be based on the owner’s life expectancy (using the new table) in 1995 reduced by 8.
Under the 2001 proposed regulations, the beneficiary had to be alive as of 12/31 of the
year following the owner’s death to be considered valid. Under the 2002 regulations, the
beneficiary only has to be alive when the owner dies to be considered.
Situation 3: Owner dies with nonspousal beneficiary
In the year of death, the minimum distribution is still calculated according to Situation 1
(above). It’s only in the years after the owner’s death that this situation applies.
When the owner dies with a nonspousal beneficiary, a term certain distribution period is
established based on the designated beneficiary’s single life expectancy in the year after
the owner’s death. Unlike Situation 2, in this case the term is based on a life expectancy
calculated in the year after the owner’s death, rather than the year of death. For example,
if the owner died in 2003, the life expectancy used as the divisor in 2004 would be the
beneficiary’s single life expectancy in 2004. In 2005, the divisor used would be 2004’s
number minus 1. The life expectancy in the year after death is, of course, calculated using
the new single life expectancy table, and, as with Situation 2, an existing term certain
would have to be recalculated using the new table.
The 2002 final regulations add another wrinkle to those situations when the owner died
on or after the required beginning date. In these situations, the life expectancy used is the
greater of the one calculated using the “no beneficiary” case (situation 2), and the one
resulting from the calculation described in the previous paragraph. This can get a little
confusing, because the “no beneficiary” case starts with a term calculated in the year of
death, while the nonspousal beneficiary’s term certain starts the year after the owner’s
death.
Situation 4: Owner dies with spousal beneficiary
In the year of death, the minimum distribution is still calculated according to Situation 1
(above). It’s only in the years after the owner’s death that this situation applies.
When the owner dies with a spousal beneficiary, the spouse gets special treatment. In this
case, the distributions are based on the spouse’s single life expectancy recalculated each
year after the owner’s death. If the owner dies prior to the calendar year in which he
would have reached age 70½, the spouse does not have to start taking distributions until
that year. Upon the spouse’s death, the distributions become term certain, with the term
set to the spouse’s life expectancy in the year of death. This works the same as the old
term certain method, with the life expectancy being reduced by one for each year that
passes after the spouse’s death.
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As with situation 3, the 2002 final regulations add more complexity. For cases where the
client dies on or after the required beginning date, the life expectancy used is the greater
of the one calculated using the “no beneficiary” case (situation 2), and the one resulting
from the calculation described in the previous paragraph.
When do these apply?
In 2002, there is the option of using either the pre-2001 proposed regulations (with all
their calculation and recalculation options), the 2001 proposed regulations, and the 2002
final regulations. After 2002, only the 2002 final regulations may be used.
The 2002 final regulations added more than just a new mortality table to these
calculations. They also added complexity. When all the different situations listed above
are taken together, they represent a fairly complicated set of calculations that have to be
correctly performed to make sure you calculate the correct distribution for your clients.
 2002, Brentmark Software, Inc. All Rights Reserved.

Calculating Required Minimum Distributions using the 2001 Proposed
Regulations:
The regulations released on 1/11/2001 radically changed the way minimum distributions
have to be calculated. They eliminated a lot of complexity reduced the number of
decisions made by a plan owner. These regulations eliminated the old recalculation
options. There is no "hybrid method" or "joint term certain method." However, the new
methodology does still have some similarities to the old. For example, the distribution is
still calculated by dividing the previous year's balance by a life expectancy number.
Here’s how it works:
Situation 1: Owner still alive
If the owner is still alive, the distributions are based on the divisor found in the MDIB
table for owner’s age. The MDIB table is a published table of joint life expectancies for
an owner and a beneficiary who is ten years younger than the owner. It simplifies the
calculation to only using the owner’s age. No beneficiary information is needed, and no
recalculation options are available. There is only one exception to this rule – for cases
involving spousal beneficiaries that are more than ten years younger than the owner.
Situation 2: Owner dies with nonspousal beneficiary
When the owner dies with a nonspousal beneficiary, a term certain distribution period is
established, based on the designated beneficiary's single life expectancy in the year after
the owner’s death. As with the old term certain method, this life expectancy is simply
reduced by one for each year after it is calculated.
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Situation 3: Owner dies with no beneficiary
This is the only situation where the owner’s required beginning date is relevant. If the
owner dies before the required beginning date, and there is no beneficiary alive as of
12/31 of the year following the owner's death, the five year rule applies – all the money
has to be distributed within the next five years.
If the owner dies after the required beginning date, and there is no beneficiary alive as of
12/31 of the year following the owner’s death, the distributions are taken out over a term
based on the owner’s life expectancy in the year of death. Once again, this works the
same as the old term certain method, with the life expectancy being reduced by one for
each year that passes after the owner’s death.
Situation 4: Owner dies with spousal beneficiary
When the owner dies with a spousal beneficiary, the spouse gets special treatment. In this
case, required distributions are generally based on the spouse’s single life expectancy in
each year after the owner’s death.
If the owner dies prior to the calendar year in which he would have reached age 70½, the
spouse does not have to start taking distributions until that year. However, if the owner
dies before 12/31 of the calendar year in which he would have reached age 70½ and the
spouse also dies before 12/31 of the calendar year in which the original owner would
have reached age 70½, then the second-to-die spouse is treated as the new owner with the
rules of Situation 2 being applied if the second-to-die spouse has a designated beneficiary
or Situation 3 if there is no designated beneficiary.
If the spouse dies after the year in which the original owner would have turned 70½, the
distributions become term certain, with the term set to the spouse’s life expectancy in the
year of death. Again, this works the same as the old term certain method, with the life
expectancy being reduced by one for each year that passes after the spouse’s death.
Situation 5: Owner dies and a spousal rollover
When the owner dies with a spousal beneficiary, the spouse has the option of doing a
spousal rollover with the spouse becoming the new owner. In such a case, the rules of
Situation 1 apply after the spouse becomes the new owner.
Situation 6: The Exception to Situation 1
The exception to situation 1 is when there is a spousal beneficiary who is more than 10
years younger than the owner. In this case, the life expectancy used while the owner is
alive is the joint life expectancy of the owner and spouse, recalculated in each year. Once
the owner dies, the exception no longer applies, and the distribution is handled according
to the situations described above.
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1987 Proposed Regulations (Pre-2001 Rules)
If the plan owner has not named a beneficiary
If the plan owner has not named a beneficiary, then there are two methods for
determining the plan owner’s life expectancy each year: Term Certain method or
Recalculation method. Use the Recalculate Owner’s Life Exp. check box to determine the
method:
•
Term Certain method—Clear the Recalculate Owner’s Life Exp. check box. The
program uses Table V to determine the owner’s life expectancy in for the Required
Beginning Date (first year that distributions are required). Thereafter, the program
subtracts one from the life expectancy each year.
•
Recalculation method—Click the Recalculate Owner’s Life Exp. check box. The
program uses Table V to determine the life expectancy each year.
If the plan owner has named a beneficiary
Plan owners and beneficiaries have the ability to recalculate their life expectancies
annually (see Note). If the plan owner has named a beneficiary, then there are actually
four methods of recalculating life expectancies each year. Use the Recalculate Owner’s
Life Exp. and the Recalculate Beneficiary’s Life Exp. check boxes to determine the
method:
Joint Recalculation method—Click both check boxes. Both life expectancies are
recalculated. The program uses Table VI to determine the minimum distribution from the
life expectancies.
Joint Term Certain method—Clear both check boxes. Neither life expectancy is
recalculated. Both the owner and the beneficiary use the term certain method. Both life
expectancies decrease by 1 annually.
Hybrid method—Only click Recalculate Owner’s Life Exp. The owner's life expectancy
is recalculated and the beneficiary uses the term certain method. Using the beneficiary's
deemed age ((determined using single life Table V) and the owner's actual age, the
program uses joint life Table VI to determine the minimum distribution. Many planners
recommend this method when the plan owner is older than the beneficiary.
Hybrid method—Only click Recalculate Beneficiary’s Life Exp. The beneficiary's life
expectancy is recalculated, and the owner uses the term certain method. Using the
owner's deemed age (determined using single life Table V) and the beneficiary's actual
age, the program uses joint life Table VI to determine the minimum distribution. Planners
recommend this variant when the beneficiary is older than the plan owner.
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Mortality Table
The program offers the 90CM Table, the §1.72 (1983 table listed in IRS Regulations
§1.72-7(c)(1)(iii)), the UP-1984, and the 80CNSMT (1980 table from IRS publication
1457). The example in IRS Notice 89-25, 1989-1 C.B. 662 uses the UP-1984 Mortality
Table. As of May 1, 1999, the IRS released the 90CM mortality table. This table replaces
the older 80CNSMT. Between May 1, 1999, and June 30, 1999, you can use either the
80CNSMT or the 90CM. After June 30, 1999, do not use the 80CNSMT (REG-10385199).
Note
Brentmark has permission to use the UP-1984 Table Copyright(c) 1976 Conference of Consulting Actuaries,
All Rights Reserved.

Reasonable Interest Rate
A so-called “reasonable” interest rate is required when using the Amortization or Annuity
Factor methods to compute a pre-59½ plan distribution that avoids the 10% penalty for
early distributions. The program limits you to entering a rate no higher than the Afrs for
the previous two months.
Prior to 2002, see IRS Notice 89-25, 1989-1 C.B. 662, Q&A 11 and 12. In various letter
rulings, the IRS has accepted use of the 120% Annual Long-Term Applicable Federal
Rate for the month in which distributions start. Some commentators read some of the
rulings as saying that you should use 120% of the Annual Long-Term Rate, which is
slightly different. However, the difference may be seen as de minimus. If you judge this
rate to be appropriate, it may be used in the Pension Distributions Calculator. Letter
Rulings cannot be used as binding authority for IRS positions. Since the IRS has not
issued any rulings other than Letter Rulings on the topic of "reasonable" interest rates for
pre-59½ distributions, there is no binding authority on this topic.
These rates are posted on Brentmark’s web site, http://www.brentmark.com.

Type of Plan
The program calculates required minimum distributions for the following types of
pension plans:
•

Corporate and self-employed pension, profit sharing and stock bonus plans
qualified under IRC Sec. 401(a) (includes Keogh or H.R. 10 plans, 401(k) plans,
and employee stock ownership plans or ESOPs),

•

Individual Retirement Accounts (IRAs) under IRC Sec. 408(a),

•

Simplified Employee Plans (SEPs) under IRC Sec. 408(k), and
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•

Tax-sheltered annuities (except for account balances existing on 12/31/86 if kept
separate for accounting purposes) under IRC Sec. 403(b). The Pension
Distributions Calculator classifies retirement plans into three groups:

When calculating minimum distributions, you need to select a Type of Plan. Following
are descriptions of the choices that the program provides.
Normal

This is the most common selection if the plan owner is retiring on or before age 70, and
the plan is not a Roth IRA.
Roth IRA

The Roth IRA was created by the Taxpayer Relief Act of 1997. There are no required
distributions until the year after the plan owner dies. The required beginning date of
minimum distributions from a Roth IRA is the year after the owner’s death. At that point,
the minimum distributions are calculated based on the beneficiary's single life
expectancy.
If the beneficiary is the Roth IRA owner’s spouse, the election to recalculate the
beneficiary's single life expectancy each year after the required beginning date is
available. For nonspousal beneficiaries, the life expectancy is calculated once and
reduced by one for each year after the required beginning date.
<5% Owner

Use this selection if the owner is planning to retire after age 70½ and owns no more than
5% of a company with a plan that is not an IRA. If the plan owner owns no more than 5%
of a company with a pension plan that is not an IRA, the required minimum distributions
are delayed until the retirement year.

Rev. Rul. 2002-62; 2002-42 IRB 1 (3 Oct 2002)
Part I
Section 72.--Annuities; Certain Proceeds of Endowment and Life Insurance Contracts
SECTION 1. PURPOSE AND BACKGROUND
.01 The purpose of this revenue ruling is to modify the provisions of Q&A-12 of Notice
89-25, 1989-1 C.B. 662, which provides guidance on what constitutes a series of
substantially equal periodic payments within the meaning of § 72(t)(2)(A)(iv) of the
Internal Revenue Code from an individual account under a qualified retirement plan.
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Section 72(t) provides for an additional income tax on early withdrawals from qualified
retirement plans (as defined in § 4974(c)). Section 4974(c) provides, in part, that the
term “qualified retirement plan” means (1) a plan described in § 401 (including a trust
exempt from tax under § 501(a)), (2) an annuity plan described in § 403(a), (3) a taxsheltered annuity arrangement described in § 403(b), (4) an individual retirement account
described in § 408(a), or (5) an individual retirement annuity described in § 408(b).
.02 (a) Section 72(t)(1) provides that if an employee or IRA owner receives any amount
from a qualified retirement plan before attaining age 59½, the employee’s or IRA
owner’s income tax is increased by an amount equal to 10-percent of the amount that is
includible in the gross income unless one of the exceptions in § 72(t)(2) applies.
(b) Section 72(t)(2)(A)(iv) provides, in part, that if distributions are part of a series of
substantially equal periodic payments (not less frequently than annually) made for the life
(or life expectancy) of the employee or the joint lives (or joint life expectancy) of the
employee and beneficiary, the tax described in § 72(t)(1) will not be applicable. Pursuant
to § 72(t)(5), in the case of distributions from an IRA, the IRA owner is substituted for
the employee for purposes of applying this exception.
(c) Section 72(t)(4) provides that if the series of substantially equal periodic payments
that is otherwise excepted from the 10-percent tax is subsequently modified (other than
by reason of death or disability) within a 5-year period beginning on the date of the first
payment, or, if later, age 59½, the exception to the 10-percent tax does not apply, and the
taxpayer’s tax for the year of modification shall be increased by an amount which, but for
the exception, would have been imposed, plus interest for the deferral period.
(d) Q&A-12 of Notice 89-25 sets forth three methods for determining whether payments
to individuals from their IRAs or, if they have separated from service, from their
qualified retirement plans constitute a series of substantially equal periodic payments for
purposes of § 72(t)(2)(A)(iv).
(e) Final Income Tax Regulations that were published in the April 17, 2002, issue of the
Federal Register under § 401(a)(9) provide new life expectancy tables for determining
required minimum distributions.
SECTION 2. METHODS
.01 General rule. Payments are considered to be substantially equal periodic payments
within the meaning of § 72(t)(2)(A)(iv) if they are made in accordance with one of the
three calculations described in paragraphs (a) – (c) of this subsection (which is comprised
of the three methods described in Q&A-12 of Notice 89-25).
(a) The required minimum distribution method. The annual payment for each year is
determined by dividing the account balance for that year by the number from the chosen
life expectancy table for that year. Under this method, the account balance, the number
from the chosen life expectancy table and the resulting annual payments are redetermined
for each year. If this method is chosen, there will not be deemed to be a modification in
the series of substantially equal periodic payments, even if the amount of payments
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changes from year to year, provided there is not a change to another method of
determining the payments.
(b) The fixed amortization method. The annual payment for each year is determined by
amortizing in level amounts the account balance over a specified number of years
determined using the chosen life expectancy table and the chosen interest rate. Under
this method, the account balance, the number from the chosen life expectancy table and
the resulting annual payment are determined once for the first distribution year and the
annual payment is the same amount in each succeeding year.
(c) The fixed annuitization method. The annual payment for each year is determined by
dividing the account balance by an annuity factor that is the present value of an annuity
of $1 per year beginning at the taxpayer's age and continuing for the life of the taxpayer
(or the joint lives of the individual and beneficiary). The annuity factor is derived using
the mortality table in Appendix B and using the chosen interest rate. Under this method,
the account balance, the annuity factor, the chosen interest rate and the resulting annual
payment are determined once for the first distribution year and the annual payment is the
same amount in each succeeding year.
.02 Other rules. The following rules apply for purposes of this section.
(a) Life expectancy tables. The life expectancy tables that can be used to determine
distribution periods are: (1) the uniform lifetime table in Appendix A, or (2) the single
life expectancy table in § 1.401(a)(9)-9, Q&A-1 of the Income Tax Regulations or (3) the
joint and last survivor table in § 1.401(a)(9)-9, Q&A-3. The number that is used for a
distribution year is the number shown from the table for the employee’s (or IRA owner’s)
age on his or her birthday in that year. If the joint and survivor table is being used, the
age of the beneficiary on the beneficiary’s birthday in the year is also used. In the case of
the required minimum distribution method, the same life expectancy table that is used for
the first distribution year must be used in each following year. Thus, if the taxpayer uses
the single life expectancy table for the required minimum distribution method in the first
distribution year, the same table must be used in subsequent distribution years.
(b) Beneficiary under joint tables. If the joint life and last survivor table in §1.401(a)(9)9, Q&A-3, is used, the survivor must be the actual beneficiary of the employee with
respect to the account for the year of the distribution. If there is more than one
beneficiary, the identity and age of the beneficiary used for purposes of each of the
methods described in section 2.01 are determined under the rules for determining the
designated beneficiary for purposes of § 401(a)(9). The beneficiary is determined for a
year as of January 1 of the year, without regard to changes in the beneficiary in that year
or beneficiary determinations in prior years. For example, if a taxpayer starts
distributions from an IRA in 2003 at age 50 and a 25-year-old and 55-year-old are
beneficiaries on January 1, the 55-year-old is the designated beneficiary and the number
for the taxpayer from the joint and last survivor tables (age 50 and age 55) would be 38.3,
even though later in 2003 the 55-year-old is eliminated as a beneficiary. However, if that
beneficiary is eliminated or dies in 2003, under the required minimum distribution
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method, that individual would not be taken into account in future years. If, in any year
there is no beneficiary, the single life expectancy table is used for that year.
(c) Interest rates. The interest rate that may be used is any interest rate that is not more
than 120 percent of the federal mid-term rate (determined in accordance with § 1274(d)
for either of the two months immediately preceding the month in which the distribution
begins). The revenue rulings that contain the § 1274(d) federal mid-term rates may be
found at www.irs.gov\tax_regs\fedrates.html.
(d) Account balance. The account balance that is used to determine payments must be
determined in a reasonable manner based on the facts and circumstances. For example,
for an IRA with daily valuations that made its first distribution on July 15, 2003, it would
be reasonable to determine the yearly account balance when using the required minimum
distribution method based on the value of the IRA from December 31, 2002 to July 15,
2003. For subsequent years, under the required minimum distribution method, it would
be reasonable to use the value either on the December 31 of the prior year or on a date
within a reasonable period before that year’s distribution.
(e) Changes to account balance. Under all three methods, substantially equal periodic
payments are calculated with respect to an account balance as of the first valuation date
selected in paragraph (d) above. Thus, a modification to the series of payments will
occur if, after such date, there is (i) any addition to the account balance other than gains
or losses, (ii) any nontaxable transfer of a portion of the account balance to another
retirement plan, or (iii) a rollover by the taxpayer of the amount received resulting in such
amount not being taxable.
.03 Special rules. The special rules described below may be applicable.
(a) Complete depletion of assets. If, as a result of following an acceptable method of
determining substantially equal periodic payments, an individual’s assets in an individual
account plan or an IRA are exhausted, the individual will not be subject to additional
income tax under § 72(t)(1) as a result of not receiving substantially equal periodic
payments and the resulting cessation of payments will not be treated as a modification of
the series of payments.
(b) One-time change to required minimum distribution method. An individual who
begins distributions in a year using either the fixed amortization method or the fixed
annuitization method may in any subsequent year switch to the required minimum
distribution method to determine the payment for the year of the switch and all
subsequent years and the change in method will not be treated as a modification within
the meaning of § 72(t)(4). Once a change is made under this paragraph, the required
minimum distribution method must be followed in all subsequent years. Any subsequent
change will be a modification for purposes of § 72(t)(4).
SECTION 3. EFFECTIVE DATE AND TRANSITIONAL RULES
The guidance in this revenue ruling replaces the guidance in Q&A-12 of Notice
89-25 for any series of payments commencing on or after January 1, 2003, and may be
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used for distributions commencing in 2002. If a series of payments commenced in a
year prior to 2003 that satisfied § 72(t)(2)(A)(iv), the method of calculating the payments
in the series is permitted to be changed at any time to the required minimum distribution
method described in section 2.01(a) of this guidance, including use of a different life
expectancy table.
SECTION 4. EFFECT ON OTHER DOCUMENTS
Q&A-12 of Notice 89-25 is modified.
SECTION 5. REQUEST FOR COMMENTS
The Service and Treasury invite comments with respect to the guidance provided in this
revenue ruling. Comments should reference Rev. Rul. 2002-62.
Comments may be submitted to CC:ITA:RU (Rev. Rul. 2002-62, room 5226, Internal
Revenue Service, POB 7604 Ben Franklin Station, Washington, DC 20044. Comments
may be hand delivered between the hours of 8:30 a.m. and 5 p.m. Monday to Friday to:
CC:ITA:RU (Rev. Rul. 2002-62), Courier's Desk, Internal Revenue Service, 1111
Constitution Avenue NW., Washington, D.C. Alternatively, comments may be submitted
via the Internet at Notice.Comments@irscounsel.treas.gov. All comments will be
available for public inspection and copying.
Drafting Information
The principal author of this revenue ruling is Michael Rubin of the Employee
Plans, Tax Exempt and Government Entities Division. For further information regarding
this revenue ruling, please contact Mr. Rubin at 1-202-283-9888 (not a toll-free number).

Discussion of Revenue Ruling 2002-62
Revenue Ruling 2002-62 is more than just a minor refinement of the way substantially
equal periodic payments are calculated. It has made significant changes to all three
method and clarifies some previously questionable areas. Unfortunately, it still leaves a
lot of gray areas.

As a brief refresher, IRS Notice 89-25 established three ways of calculating
“substantially equal periodic payments” to avoid the 10% penalty on early withdrawals
from qualified retirement plans. Rev. Rul. 2002-62 replaces the guidance of IRS Notice
89-25.
The first of the three methods, “the required minimum distribution method,” allows for
distributions to be calculated in the same manner that minimum distributions are
calculated. Since these distributions are almost always calculated using the Uniform
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Lifetime Table, the Revenue Ruling extended the beginning of this table to include all
ages from 10 through 115. The single life expectancy table and joint life expectancy
tables may still be used as well. The calculation is the same as it was prior to the ruling,
requiring the distribution to be recalculated each year based on the life expectancy, but
now the Uniform Lifetime Table is available in addition to the single and joint life
expectancy tables. It’s worth noting that once a life expectancy table is selected, it must
be used for the duration of the distributions.
The second of the three methods, “the fixed amortization method,” has been little
changed by the ruling. The distribution amount is still calculated just once, based on
amortizing the plan balance over the applicable life expectancy. The only change the
Revenue Ruling made was to give the plan owner the choice of three life expectancy
tables: single, joint, or the Uniform Lifetime Table.
The third of the three methods, “the fixed annuitization method,” requires the
distributions to be calculated through the use of an annuity factor. Prior to Revenue
Ruling 2002-62, this annuity factor had to be calculated from a “reasonable mortality
table.” Now, only the mortality table from the Ruling can be used. As with the
amortization method, the distribution is calculated only once and that distribution amount
is used throughout the distribution period.
These three methods are all basically the same as they were previously, with slightly
different details to the calculations. The biggest change implemented by Revenue Ruling
2002-62 came in the form of a clarification. Previously, the “reasonable interest rate”
required by IRS Notice 89-25 was generally assumed to mean the 120% annual long-term
rate. The Ruling establishes that the 120% federal mid-term interest rate is the maximum
allowable interest rate for the calculation. Decreasing the allowable rate by that much (in
October 2002, a difference of 1.73%) significantly decreases the distributions allowed
under the amortization and annuitization distribution methods.
Revenue Ruling 2002-62 also eliminates the possibility of recalculating distributions
when using either the amortization or annuitization distribution methods. Recalculating
these distributions had started to become popular after it was allowed in a couple letter
rulings, but the Rev. Rul. 2002-62 makes it clear that only the minimum distribution
method can be recalculated. It does allow for plan owners to switch to that method,
allowing some relief for people whose plans are losing money.
Another interesting change made by the Revenue Ruling is that distributions must now be
calculated for distributions that are occurring right away. The Ruling sets the maximum
allowable interest rate to be the higher of the mid-term rates from the two months prior to
the first distribution. Obviously, this means that we cannot do a calculation in 2002 for a
2003 distribution, because there’s no way to know what the maximum rate is.
Unfortunately, Revenue Ruling 2002-62 speaks only in terms of annual distributions. It
does nothing to clear up the question of distributions that are taken more frequently than
annual. Should monthly distributions be calculated by just dividing the annual
distribution by 12? Maybe. Annuity factors typically account for frequency of
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distributions, so it would seem that the calculation of the distribution amount under the
annuitization method should do so. Amortization schedules always account for frequency
of payments as well: paying a mortgage monthly versus paying it annually results in a
different annual payment amount. Of the three methods, the minimum distributions
method seems like the only one where the frequency of distributions would have no
affect on the annual distribution amount. Revenue Ruling 2002-62 does not address this
issue at all, however.

Private Letter Rulings
Private Letter Rulings (among them: 9531039, 9010075, and 9241063) illustrate an
annual recalculation of distributions for the annuity factor and amortization methods.
More specifically, in years after the first year, the distributions are recalculated using the
balance as of the beginning of each year. If you wish to see the distributions calculated
using the methodology of the Letter Rulings, select "Private Letter Rulings" for the
choice. The program includes disclaimer language on all reports that use the method of
the Private Letter Rulings.

LTR 9010075
Date: December 14, 1989
Refer Reply to: E:EP:R:7

LEGEND:
Individual A = * * *
Individual B = * * *
Dear * * *
This is in response to a letter from Individual A's authorized representative dated August
17, 1989, as supplemented by a letter dated October 9, 1989, in which Individual A's
representative requested a private letter ruling on his behalf regarding the income tax
consequences of proposed distributions from Individual A's individual retirement account
("IRA").
You have submitted the following representations of fact:
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Individual A established an IRA with funds rolled over from distributions from
retirement plans qualified under section 401(a) of the Internal Revenue Code. Individual
A desires to institute periodic distributions from his IRA which would be part of a series
of substantially equal periodic payments (not less frequently than annually) made over
the joint life expectancies of Individual A and Individual B, his wife.
An assumed interest rate would be based on the federal long-term interest rate published
and in effect as of June 1, 1989. Table VI of section 1.72-9 of the Income Tax
Regulations will be used for purposes of initially computing the life expectancy of
Individual A and Individual B, who is the designated beneficiary of the IRA account,
based on the attained ages of Individuals A and B as of July 1, 1989.
Distributions in a given year would be in monthly installments intended to amortize the
entire balance of the individual retirement account in uniform monthly installments over
the joint life expectancy as initially determined on July 3, 1989, at the assumed interest
rate, based on an amortization schedule as set forth in the "Loan Payments Handbook"
published by Computo Facts, 209 Shepherd Avenue Bast, Willow Dale, Ontario, Canada
M2N 5W2. Withdrawals would be made in equal monthly installments throughout each
calendar year. During calendar year 1989, the monthly installments for the short calendar
year would equal a proportionate part of an entire year's distributions.
The fair market value of the IRA would initially be determined on July 1, 1989, and
would be redetermined as of December 31st of each year. The monthly periodic
distributions from the IRA for the following year would then be adjusted solely to reflect
the change in the fair market value of the IRA as of that December 31st. In each calendar
year after 1989, the monthly installments would be adjusted by reducing the life
expectancy by one year, and by adjusting the fair market value of the IRA as the
December 3let of the immediately preceding year.
Based on the foregoing, Individual A requests, through his authorized representative, a
ruling that the method of distribution described hereinabove will qualify as a series of
substantially equal periodic payments (not less frequently than annually) made for the
joint life expectancy of Individual A and his designated beneficiary, within the meaning
of section 72(t)(2)(A)(iv) of the Code.
Section 72(t)(1) of the Code states that if any taxpayer receives any amount from a
qualified retirement plan (as defined in section 4974(c) of the Code), the taxpayer's tax
for the taxable year in which such amount is received shall be increased by an amount
equal to 10 percent of the portion of such amount which is includible in gross income.
Section 4974(c) of the Code defines the term "qualified retirement plan" to include an
individual retirement account described in section 408(a) of the Code.
Section 72(t)(2) of the Code provides that the additional income tax imposed by section
72(t)(1) shall not apply to distributions enumerated therein. With specific reference to the
distribution method at issue in this ruling request, section 72(t)(2)(a)(iv) provides that this
tax shall not apply to distributions which are part of a series of substantially equal
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periodic payments (not less frequently than annually) made for the life (or life
expectancy) of the employee or the joint lives (or joint life expectancies) of the employee
and his designated beneficiary.
Notice 89-25, 1989-12 I.R.B. 68, March 20, 1989, Q&A 12, provides 3 methods by
which a series of distributions may satisfy the substantially equal periodic payments
exception of section 72(t)(2)(A)(iv) of the Code. The payment methods described in
Notice 89-25 are intended to serve as examples of substantially equal periodic payments
and are not the only distribution methods which will satisfy the requirements of section
72(t)(2)(A)(iv) of the Code.
Individual A's proposed method of distribution is consistent with the guidelines set forth
in Notice 89-25. Accordingly, we conclude that distributions in accordance with that
method will qualify as being part of a series of substantially equal periodic payments (not
less frequently than annually) made for the joint life expectancy of Individual A and his
designated beneficiary, within the meaning of section 72(t)(2)(A)(iv) of the Code.
This ruling is based on the assumption that distributions from the IRA will not be
modified from the method of distribution described hereinabove in violation of section
72(t)(4) of the Code.
A copy of this ruling is being sent to your authorized representative pursuant to a power
of attorney on file in this office.
Sincerely yours,
Joyce E. Floyd
Chief, Employee Plans
Rulings Branch

Enclosures:
Deleted Copy
Notice of Intention to Disclose
Deputy Assistant Chief Counsel

LTR 9241063
Date: July 16, 1992
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Refer Reply to: E:EP:PA
In re: * * *
Dear * * *
This letter is in response to your request, in a letter dated May 8, 1990, for a ruling letter
as to whether certain proposed distributions from Plan L to Participant G are part of a
series of substantially equal periodic payments and are therefore not subject to the 10%
additional tax imposed on early distributions under Internal Revenue Code (I.R.C.)
section 72(t). This ruling replaces the prior ruling for this taxpayer dated June 7, 1991 (
PLR 9135060).
According to the information received Taxpayer W was incorporated from December 1,
1972 to December 31, 1989 as a Professional Corporation with one employee, Participant
G. Effective December 1, 1972, Plan L was established and during its existence had only
one participant, Participant G. Plan L was amended effective November 1, 1984 to cease
any future allocations under the Plan. Participant G retired from employment with
Taxpayer W in November 1988 at the age of 50. Participant G's date of birth is January 5,
1938. Plan L has been an ongoing plan since the amendment to cease allocations and
Forms 5500 for the Plan have been filed for all subsequent plan years. Participant G
would like to begin receiving distributions from Plan L with the annual distribution
amount to be determined by amortizing his account balance over the number of years
equal to his life expectancy (obtained from Table V in the Income Tax Regulations (Tres.
Reg.) section 1.72-9) at an assumed interest rate of earnings equal to the Long Term
Federal Rate used for purposes of I.R.C. section 1288(b). The annual amount would be
distributed as a single payment on January 1.
I.R.C. section 402(a) provides that the amount actually distributed to any distributee by
any employees' trust described in I.R.C. section 401(a) shall be taxable to him, in the year
in which so distributed under I.R.C. section 72.
I.R.C. section 72 provides rules for the taxation of amounts received as annuities,
endowments, or life insurance contracts and distributions from qualified plans.
I.R.C. section 72(t)(1) provides for the imposition of an additional 10% tax on early
distributions from qualified plans, including IRAs. The additional tax is imposed on that
portion of the distribution which is includible in gross income. I.R.C. section
72(t)(2)(A)(iv) provides that I.R.C. section 72(t)(1) shall not apply to distributions made
to an employee which are part of a series of substantially equal periodic payments (not
less frequently than annually) made for the life (or life expectancy) of the employee or
the joint lives (or joint life expectancies) of such employee and his beneficiary.
I.R.C. section 72(t)(4) provides that the 10% tax of I.R.C. section 72(t) will apply if the
series of payments is subsequently modified (other than by reason of death or disability)
before the later of (1) the close of the 5-year period beginning with the date of the first
payment, and (2) the employee's attainment of age 59-1/2. In such a case, the taxpayer's
tax for the first taxable year in which such modification occurs shall be increased by an
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amount determined under regulations, equal to the tax which would have been imposed
except for the I.R.C. section 72(t)(2)(A)(iv) exception, plus interest for the deferral
period.
Tres. Reg. section 1.72-9 provides tables that are to be used in connection with
computations under I.R.C. section 72 and the regulations thereunder. Included in this
section are tables giving life expectancies for one life (Table V) and joint life and last
survivor expectancies for two lives (Table VI).
The proposed method for determining periodic annual payments is to determine an
annual payment as of January 1 of the distribution year by amortizing the account balance
under the Plan as of December 31 of the prior year over a number of years equal to the
life expectancy of Participant G determined as follows: For the initial distribution, the life
expectancy is to be that stated in Table V of Tres. Reg. section 1.72-9 using the
participant's age as of January 1 of the initial distribution year. In subsequent distribution
years, the life expectancy shall be one year less than the prior year's life expectancy. The
assumed interest rate of return used to compute the annual payments is equal to the
Federal Long-Term Rate (compounded annually) which is used for purposes of I.R.C.
section 1288(b) and which is in effect for December of the prior year. The annual
distribution amount will be recalculated each year in the same manner using the
applicable interest rate and life expectancy. The life expectancy and the interest rate used
are such that they do not result in the circumvention of the requirements of I.R.C. section
72(t)(2)(A)(iv) and I.R.C. section 72(t)(4) (through the use of an unreasonably high
interest rate or an unreasonable life expectancy).
Accordingly, we conclude that the proposed method (as modified) of determining
periodic payments results in substantially equal periodic payments within the meaning of
I.R.C. section 72(t)(2)(A)(iv). Accordingly, such payments will not be subject to the
additional tax of I.R.C. section 72(t) unless I.R.C. section 72(t)(4) requires that the tax be
paid.
Sincerely yours,
James E. Holland, Jr.
Chief, Pension Actuarial Branch
Date: May 1, 1992
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LTR 9531039

Date: May 10, 1995
Refer Reply to: CP:E:EP:A:2
In re: * * *

Dear * * *
This letter is in response to your request, dated November 29, 1993, for a ruling on behalf
of Taxpayer M as to whether certain proposed distributions from two individual
retirement accounts (IRAs) owned by Taxpayer M are part of a series of substantially
equal periodic payments and are therefore not subject to the 10% additional tax imposed
under section 72(t) of the Internal Revenue Code (Code) on early distributions. The
original request was modified by a letter faxed to our office on May 9, 1994, and in
telephone calls with our office in the following ways: the methodology and assumptions
used to calculate the annuity factor were changed; the year in which the stream of
payments will commence was changed to 1995; and the account balance to be used for
calculating payments was modified.
According to the facts, Taxpayer M, born on March 16, 1940, is the owner of two IRAs,
IRA 1 and IRA 2. Assets held in one of the two IRAs are, periodically, transferred to the
other of the two IRAs. Taxpayer M would like to start receiving annual payments from
these two IRAs in 1995. The two IRAs will be aggregated for purposes of calculating an
annual distribution amount, and the distribution amount will be taken out of IRA 1 or
IRA 2 or both IRA 1 and IRA 2. The annual distribution amount for 1995 will be
calculated by dividing the total aggregated account balance as of December 31, 1994, of
IRAs 1 and 2 by an annuity factor. The annuity factor will be calculated using
commutation functions based on the UP-1984 Mortality Table, Taxpayer M's age attained
in 1995, and an interest assumption equal to the annually compounded Mid-Term
Applicable Federal Rate used for purposes of section 1274(d) of the Code in effect on
January 1, 1995. Annual distribution amounts for subsequent years will be calculated in a
similar manner by dividing the aggregated account balance of IRA 1 and IRA 2 as of
December 31 of the prior year by an annuity factor, calculated using commutation
functions based on the UP-1984 Mortality Table, the age attained in the distribution year,
and an interest assumption equal to the annually compounded Mid-Term Applicable
Federal Rate in effect on January 1 of the distribution year.
Section 408(d) of the Internal Revenue Code provides that amounts paid or distributed
out of an individual retirement plan must be included in gross income by the payee or
distributee in the manner provided under section 72 of the Code.
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Section 72 of the Internal Revenue Code provides rules for determining how amounts
received as annuities, endowments, or life insurance contracts and distributions from
qualified plans are to be taxed.
Section 72(t) of the Internal Revenue Code was added to the Code by the Tax Reform
Act of 1986 (TRA '86), effective generally for taxable years beginning after December
31, 1986. Section 72(t)(1) provides for the imposition of an additional 10% tax on early
distributions from qualified plans, including IRAs. The additional tax is imposed on that
portion of the distribution which is includible in gross income.
Section 72(t)(2)(A)(iv) of the Code provides that section 72(t)(1) shall not apply to
distributions which are part of a series of substantially equal periodic payments (not less
frequently than annually) made for the life (or life expectancy) of the employee or the
joint lives (or joint life expectancies) of such employee and his beneficiary.
Section 72(t)(4) of the Code imposes the additional limitation on distributions excepted
from the 10% tax by section 72(t)(2)(A)(iv) that if the series of payments is subsequently
modified (other than by reason of death or disability) before the later of (1) the close of
the 5-year period beginning with the date of the first payment, and (2) the employee's
attainment of age 59-1/2, then the taxpayer's tax for the first taxable year in which such
modification occurs shall be increased by an amount determined under regulations, equal
to the tax which would have been imposed except for the section 72(t)(2)(A)(iv)
exception, plus interest for the deferral period.
Notice 89-25 was published on March 20, 1989, and provided guidance, in the form of
questions and answers, on certain provisions of the Tax Reform Act of 1986 (TRA '86).
In the absence of regulations on section 72(t) of the Code, this notice provided guidance
with respect to the exception to the tax on premature distributions provided under section
72(t)(2)(A)(iv). Q&A-12 of Notice 89-25 provides three methods for determining
substantially equal periodic payments for purposes of section 72(t)(2)(A)(iv) of the Code.
Two of these methods involve the use of an interest rate assumption which must be an
interest rate that does not exceed a reasonable interest rate on the date payments
commence.
The method proposed by Taxpayer M in the ruling request, as modified, for determining
annual periodic payments is to calculate an annual distribution amount for 1995 by
dividing the sum of the account balances of IRA l and IRA 2 as of December 31, 1994,
by an annuity factor which is the present value of a one dollar per year life annuity
commencing at age 55. The annuity factor is calculated using Taxpayer M's age attained
in 1995 and commutation functions derived from the UP-1984 Mortality Table where the
assumed interest rate of earnings is equal to the annually compounded Mid-Term
Applicable Federal Rate (used for purposes of Code section 1274(d)) in effect on January
1, 1995, rounded to the nearest whole or half percent. Thus, the annuity factor used in
calculating the 1995 distribution amount is calculated using a commencement age of 55
and commutation functions based on the UP-1984 Mortality Table where an interest rate
of earnings equal to 8 percent (7.92 percent, rounded to 8.0 percent) is assumed. The
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annual distribution amount will be paid from IRA 1 or IRA 2 or from both IRA 1 and
IRA 2.
Under the proposed method, as modified, the annual distribution amount will be
recalculated each year by dividing the total aggregated account balance of IRAs 1 and 2
as of December 31 of the prior year by an annuity factor which is the present value of a
one dollar per year life annuity commencing at the age attained in the distribution year.
The annuity factor will be calculated using the age attained by Taxpayer M in the
distribution year and commutation functions derived from the UP-1984 Mortality Table
where the assumed interest rate of earnings is equal to the annually compounded MidTerm Applicable Federal Rate (used for purposes of Code section 1274(d)) in effect on
January 1 of the distribution year, rounded to the nearest whole or half percent.
The mortality table and the interest rate used are such that they do not result in the
circumvention of the requirements of sections 72(t)(2)(A)(iv) and 72(t)(4) of the Code
(through the use of an unreasonable high interest rate or an unreasonable mortality table).
We conclude that the proposed method (as modified) of determining periodic payments
satisfies one of the methods described in Notice 89-25 and results in substantially equal
periodic payments within the meaning of section 72(t)(2)(A)(iv) of the Code, and such
payments will not be subject to the additional tax of section 72(t) unless the requirements
of section 72(t)(4) are not met.

Sincerely yours,
Kathryn Marticello
Chief, Actuarial Branch 2
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License Agreement
This software is protected by both United States copyright law and international treaty provisions. You
must treat this software just like a book, except that you may copy it onto a computer to be used and you
may make archival copies of the software for the sole purpose of backing up our software and protecting
your investment from loss. You must also agree not to reverse engineer the software.
By saying “just like a book,” Brentmark means, for example, that this software may be used by any number
of people, and may be freely moved from one computer location to another, so long as there is no
possibility of it being used at one location or on one computer while it is being used at another. Just as a
book cannot be read by two different people in two different places at the same time, neither can the
software be used by two different people in two different places at the same time (unless, of course,
Brentmark’s copyright is being violated).
Limited Warranty
Brentmark Software, Inc. warrants the physical diskette(s) and physical documentation enclosed herein to
be free of defects in materials and workmanship for a period of 60 days from the purchase date. If
Brentmark receives notification within the warranty period of defects in materials or workmanship, and
such notification is determined by Brentmark to be correct, Brentmark will replace the defective diskette(s)
or documentation.
The entire and exclusive liability and remedy for breach of this Limited Warranty shall be limited to
replacement of defective diskette(s) or documentation and shall not include or extend to any claim for or
right to recover any other damages, including but not limited to, loss of profit, data or use of the software,
or special, incidental or consequential damages or other similar claims, even if Brentmark has been
specifically advised of the possibility of such damages. In no event will Brentmark's liability for any
damages to you or any other person ever exceed the lower of suggested list price or actual price paid for the
license to use the software, regardless of any form of the claim.
BRENTMARK SOFTWARE, INC. SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Specifically, Brentmark makes
no representation or warranty that the software is fit for any particular purpose and any implied warranty of
merchantability is limited to the 60-day duration of the Limited Warranty covering the physical diskette(s)
and physical documentation only (and not the software) and is otherwise expressly and specifically
disclaimed.
The limited warranty gives you specific legal rights; you may have others that may vary from state to state.
Some states do not allow the exclusion of incidental or consequential damages, or the limitation on how
long an implied warranty lasts, so some of the above may not apply to you.
Governing Law and General Provisions
The License Statement and Limited Warranty shall be construed, interpreted and governed by the laws of
the State of Florida and any action hereunder shall be brought only in Florida. If any provision is found
void, invalid or unenforceable it will not affect the validity of the balance of this License and Limited
Warranty which shall remain valid and enforceable according to its terms. If any remedy hereunder is
determined to have failed of its essential purpose, all limitations of liability and exclusion of damages set
forth herein shall remain in full force and effect. This License and Limited Warranty may only be modified
in writing signed by you and a specifically authorized representative of Brentmark. All rights not
specifically granted in this statement are reserved by Brentmark.
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